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1 Introduction

This document will walk you through an evaluation of Stratusphere UX (UX stands for User eXpetlrence

VDI diagnostics and performance monitoring solution from Liquidware Labs. This is not a complete training c
user guide, but is meant to guide you through the basic steps to setup the product and to introduce you to ke
features, reports and caplii®s, so that you can determine whether Stratusphere is suitable for your VDI
monitoring needs. Itis assumed you will use the evaluation license that comes with the free version of
Stratusphere, allowing you to run the product for 10 days, and tsagsésb virtual desktops.

1.1 Topics Covered

During the course of this guide, you will:

Learn how to install and configure the Stratusphere Hub virtual appliance

Learn how to deploy Stratusphere Connector ID Keys and Network Stations

Learn the kexomponents of the Stratusphere diagnostics product module

Learn how to review environment inventory and configuration for desktops, applications
Learn how to review resource consumption data for desktops, users and applications
Learn how to generate diagst findings and results

<K<K K<L

1.2 Target Audience

This document is meant for consultants and customers who are deploying desktop virtualization in pilots or
production, and who may have use for a diagnostic tool to help measure user experience or identify
perfaomance issues. Technical skills required are minimal, however familiarity with deploying virtual desktops
and virtual machines on VMware or XenServer is expected.
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2 Diagnostics Prep 1: Install and Configure Stratusphere

This section describes the s¢dp setup monitoring for a target set of virtual desktops.

The Stratusphere Hub is a virtual appliance that you can install directly from the Liquidware Labs web site. It
is the data collector and reporting system for \di2ignosticsaand it also includethe data collection software
agents that will be deployed within the desktop VMs. The first step is to install the Hub virtual appliance on a
appropriate virtual host. Since this is a data collection and reporting appliance, it is recommended that you
deploy it on a host appropriate for server applications, not a host used for virtual desktops (although for initial
evaluation you may choose to share hosts but in this case note that Hub performance may be affected). The
virtual appliance requires 1 gigyte of memory and 4 gigabytes of disk space, and for larger product
assessments you may choose to expand memory up to 4 gigabytes of memory and may require larger disk s
to keep all data. For larger environments it is also recommended that tihas#atlbeast one dedicated CPU,

and a fast storage system (local storage can be a good solution).

The following sections describe how to configure the virtual switch and install the Stratusphere Hub virtual
appliance on either VMware vSphere or Citrix $emnver, and subsequent installation and configuration steps.

2.1 Install the Stratusphere Hub Virtual Appliance (VMware vSphere)

(%) Deploy OVF Template B EER

Source
Select the source location.

" Deploy from file:

mplete F:\LwL OVF\stratusphere_hub-daily.ovf J

Choose this option if the source OVF template (*.ovf) is on the local file system.
For example, your C: drive, a network share, or a C0y/DVD drive.

{*+ Deploy from URL:

|htt|:|:ffsu:nf'tware.quuidwarelabs.cDmH. 7.0 stratusphere_hub.owf ﬂ

Choose this option to download the OVF template from the Internet and enter a
URL such as hitp://www.example. com/template. ovf

Help | < Back | Mext = I Cancel |

L 4 The

Stratusphere Hub virtual appliance can be downloaded directly from Liquidware Labs web site onto your
VMware host. To do this, open the VMware vSphere Client and connect to your target VMware vCenter host
In the vSphere Client, select File >Deploy F Templ at eé and provide the U
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appliance (OVF) that is listed on the Liquidware Labs product download page. Complete the appliance instal
wizard by accepting the evaluation license terms, providing the name, selectwgtldata storeand network
port. The virtual appliance will then automatically be downloaded and installed.

2.2 Install the Stratusphere Hub Virtual Appliance (Citrix XenServer)

To install on XenServer, download and install the virtual appliance ontchgstt To do this, you will first

need to download the XVA .zip file from the Liquidware Labs web site ardpithe XVA. Next, open the
XenCenter Client and connect to your target XenServer host. In the XenCenter Client, select File > Import VI
and poceed through the wizard, specifying the location of the downloaded XVA file.

File | Wiews  Pool  Server WM Skc

| Impart ¥M.., E-{= Add I
B Import Search... —_—

Exik

é labxs01
= DVD drives
= Local storage

L N T

X  Import

@ g Complete the import 9

Import source
Click the Finish button to complete the import process and close the wizard.
Home server

Storage The import process may take several minutes,

Metwork

Autormatically start new W

To have your new WM stark up as soon as the import process is complete select this checkbo,

s
CiTRIX
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2.3 Install the Stratusphere Hub Virtual Appliance (Microsoft Hyper-V)

To install on Microsoft Hype¥, download and install the virtual appliance onto your host. Taidpyou will
first need to download the .zip file from the Liquidware Labs web site azipun

p anag _ |0 X
g; File Action VYiew ‘Window Help |;|i|ﬂ
= (*mHE
Actions
ouan ;
Tew » WIN-42WO00DIESE3P -
X . State CPL Uzage Lptime Operations
Import Yirtual Machine. .. o Mew 3
Hypet-4 Sethings. .. imial Running 0% 1214:56:32 | = Import Yirtual Machine. ..
Wirkual Network Manager. .. e-hub Running 0% 4.00:33:00 - )
[*=) Hyper-¥ Settings...
il Bt % wirtual Metwork Manager. ..
Inspeck Disk, ..
24 Edit Disk. ..
Stop Service
Remove Server ng Inspect Disk...
Refresh @ Stop Service
Wigw 3 | % Remaove Server
Mew Window from Here L
(@ Refresh
Help d View »
The zelected virtual machine haz no snapshots. Mew Window from Here
E Help
stratusphere-hub -
E;é Connect. ..
2 Settings...
@ Turn OFF..
@ shut Down...
@ Save
Il Pause
UD Reset
Created: 7/21/2011 5:01:55 PM Heartbeat: Mo Contact S Snapshot
Notes:  Mone Memory Usage: 1024 MB =] Rename
E Help
| 3|
|Disp|ays the import existing virtual machine user interface, | |

Next, open the Microsoft Hypar Manager Client and connect to your target Hy@gdrost. Righiclick on the
HyperV host and seledMbchheegbmmenu Yptioal

Import ¥irtual Machine | x| |

Import Path || Browse |

™ Reuse old vitual machine [Ds.

[ rpmrt I Cancel |

After import, the files under thiz import folder will be used by the imported
wirtual machine. Thiz falder cannot be imparted again.

Sel ect the fol der t hat contains the files that w
button above.
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Settings for hub481 M= e

|92 Hardware [l Add Hardware

‘fou can use this setting to add devices to wour virtual machine,

A BIOS

Bioot from 0 Select the devices you want ko add and click the Add button,
il ermory

1024 ME Metwork, Adapker
D Processor Legacy Metwork Adapter

1 Virtual processar
= i IDE Contrallzr 0
i Hard Drive
hub4a1_1.vhd
—w Hard Drive

hub4a1_2.vhd
= B IDE cantroller 1 You can attach virtual hard disks to & SC3T controller bo increase the amount of storage
) available to a wirtual machine. Install the inkegration services in the guest operating
1% DV Drive system ko improve performance when using storage attached ko a SCSI controller, Do
Mane nok attach a swskem disk ko a SCSI controller, & virtual hard disk that contains an
operating swstem must be attached to an IDE controller.

add

U Legacy Metwork Adapter
W Mebwork,

= com
Mane

= comz
Mone

[ Diskstte Drive
Mone

# Management

| Mame

hub4a1

_“'_. Integration Services
All services offered

1| Snapshot File Location
Ci\UserstAdministratorDocuments, .
-:j Aukomatic Start Action
Restart if previoushy running
-:j Automatic Stop Action
Save

Ok, I Cancel | Apply |

Once imported, select the Settings link for the imported virtual machine. You can choose tahgdateunt

of Memory and Processors associated with the Str
available hard disk controller. Please make sure the Network Adaptor is connected to a valid VM Network wit
the right VLAN ID tags.The vrtual appliance is now ready; you can start it and move to the next step.

24 Configure StratusphereE Hub

Oncompletion of the import into the virtual host, you can edit settings on the Hub to set the CPU/Memaory
settings. You can add an additional hard dvitk the required amount of space based on the

ALIi qui dwarelLabs. Stratusphere. DatabaseDiskSizingo
available at LiquidwareLabs.com. Nowwu canpower ON the virtual applianceé/ou can open a console to the
virtual appliance and watch the boot sequence. The Hub can now be configured using the Web Ul as well as

Hub console.

241 Configure StratusphétleE Hub using We

| f DHCP i s enabled on the | ocal net work subnet,
On completion of the boot sequence, the appliance will provide information on how to connect to the Web
based Administration interface of thetuial appliance. As shown in the image below, it will display the URL
that can be used to connect to the StratuspheretE

© 2010 Liquidware Labs Page7



sers (authorized or unauthorized) have no explicit or implicit
expectation of privacy.

ny or all wuses of this system and all files on this system may be
intercepted, monitored, recorded, copied, audited, inspected, and
isclosed to your employer, to authorized site, government, and law
enforcement perszonnel, as well as authorized officials of government
genciesz, both domestic and foreign.

By using this system, the user consents to such interception, monitoring,
recording, copying, auditing, inspection, and disclosure at the

iscretion of such personnel or officials. Unawuthorized or improper use
of this system may result in civil and criminal penalties and
dministrative or disciplinary action, as appropriate. By continuing to
1se this system you indicate your awareness of and consent to these terms
nd conditions of uwuse. LOG OFF IMMEDIATELY if you do not agree to the

onditions stated in this warning.
3o 3ok Jb- oE- 3o - o E BE JoE -3 JoE-JoE b b BoE JoE o JoE BE BE b o oE-E-BE b B JeEJoE Jeb b -E o oEBE -BE B3 JeE-JeE b b BoE 3eE o oE BE E oo oE -E-BE b B JeE JoE Jeb b -E o E-E E BE BE-BEJE-E BEE-BEBE

localhost login:

You can now open your browser and navigate to the URL as shown in the comms@e #bu can log into the
Administration module using the default user id and password as shown above.
File Edit View History Bookmarks Teels Help *ﬁi;aioé‘*iiia https://10.0.80.101/vscenter/app/login - =

9. LogIn | Liquidware Labs x

Q: Liquidware

Log In
Product Administration - Licensed Products:
Domain Local Directory ~ Stratusphere Fit — Assessment and capacity planning
=T ems Stratusphere UX — Diagnostics and service leve! assurance
ProfileUnity — User profile migration and management
Password

Licensed To: Evaluation License
Logln License Expires: Nov 22, 2010
Desktop Limit: 0 used out of 5
User Limit: 0 used out of 5

© 2010 Liguidware Labs, Inc.
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On successfully logging in, you will need to accept the End User License Agreement (EULA).
€ LiquidwareLabs

License

LIQUIDWARE LABS, INC. -
EVALUATION LICENSE V.2009-06
1. SCOPE OF RIGHTS.

1.1. License Grant. Liquidware Labs, Inc. ('Liquidware') grants to you ('Company') a nonexclusive, nontransferable, nonassignable, time limited license to use the
downloaded software (the 'Software") on one (1) computer for a limited period from the date of download (the 'Evaluation Period") solely for Company's (i)
internal evaluation of the Software and (ii) Company's use in your professional services engagements, without the right to further sublicense, distribute, transfer
or transmit the Software. All licenses granted are for use of the Software in object code format only, and under no circumstances will Company be entitled to
source code.

1.2. Restrictions. Except as expressly permitted in this Agreement, no express or implied license or right of any kind is granted to Company and Company shall

not (i) make any additional copies of the Software; (i) reverse assemble, decompile, or otherwise translate, or use, copy, modify, or distribute the Software by
any means; (iii) remove any copies of the Software from the site or equipment designated; or (iv) charge, or allow others to charge, any third party for use of

the Software. Company acknowledges that the Software contains keys that may limit or terminate its use.

2. NO SUPPORT. Company acknowledges that it is not eligible to receive Software support or bug fixes unless purchased separately from Liquidware.

3. TERMINATION. This Agreement and the right to use the Software will continue until the expiration of the Evaluation Period or until terminated by Liquidware.
Liquidware may terminate this Agreement for any reason upon notice to Company. Upon the expiration or termination of this Agreement, all rights and licenses
granted to Company hereunder shall terminate immediately and Company shall (i) cease all use of the Software; and (ii) delete all copies of the Software under
Company's control. Upon Liquidware's request, Company shall alse provide Liquidware with a signed written statement certifying that it has returned all
Liquidware property to Liquidware. Upon termination of this Agreement, the provisions of this Agreement concerning the ongoing interests of the parties shall
continue and survive in full force and effect.

4, DISCLAIMER OF WARRANTY. Company acknowledges and agrees that the Seftware is provided 'AS IS'. LIQUIDWARE DOES NOT MAKE ANY EXPRESS OR -

| | Agree |) Mo Thanks |

Then enter all the required registration informatdro u can choose to AG
have a product | icense keyo to paste in t

@ LiquidwareLabs

License

Thank you for downloading and installing the Liquidware Labs virtual appliance. This virtual appliance includes:

* Stratusphere Fit — for assessment and capacity planning
» Stratusphere UX — for diagnostics and service level assurance
+ ProfileUnity and ProfileUnity Pro — for user profile migration, management, and deployment integrity

Please enter your company information and license below to get started.

Registration Information

Please complete the information below to obtain techical support. Note that this information will be sent to Liquidware Labs

* Your name:  Jghn Doe

* Your email: John.Doe@mycorp.com
* Your phone number: (555) 555-1212
* Your company: My Corp
* Company installed at: My Corp

= . . .
License: @ Generate an evaluation license
I have a product license key

This evaluation license will allow you to evaluate all product capabilities for 15 days, on up
to 5 desktops. To receive a production license, or to request an extended evaluation, please

contact Liguidware Labs.

¥| 1 have read and accepted the terms of the applicable Liquidware Labs, Inc. license: Evaluation Software License, End User Software License, Fartner Agreement.

N\
(| Getstarted |)) No Thanks
N___—
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Once you click on fAGet Startedo you willebe pres

@: LiquidwareLabs

* The appliance is currently on a DHCP address. You must assign a static IP address before using the other features.
® Also, set a DNS name that corresponds to the static IP address for use by Connector ID Keys.
* We recommend turning on NTP and setting your preferred NTP Server(s)

Appliance Network Configuration

* Host Mame: hub01.mycorp.com * DNS Name: hub01.mycorp.com
Necessary for CIDs to send inspection reports

* 1P Address: 10.0.30.50 DNS Server Addresses: 10.0.10.12,10.0.10.13
Use static IP address Comma-separated
* Metwork Mask: 2552552540 DNS Search Suffixes: prod.mycorp.com, mycorp.com
Comma-separated
* Default Gateway: 10.0.80.1 Time Zone US/Eastern -
Enable NTP: [V Time Servers tick.mycorp.com, tock.mycorp.com

Comma-separated

P e ———
:Save Changes:

Cancel and Logout |

Here Is a brief description on the fields on this page:

1. Host Name: Please enter a hostname for the appliance. It can be a short name or a fully qualified host
name.

2. IP Address: Provide a static IP Address for the virtual appliance. Since the e@iaried up using
DHCP it will potentially need to give up the same address unless it's reserved within the DHCP server.
is strongly recommended to change it to a Statically allocated IP Address.

3. Network Mask

4. Default Gateway

5. DNS Name: Please enter thily qualified DNS entry name associated with this static IP Address. The
CIlD Keys wil/l cal l back to the StratuspheretE
recommended that you use a DNS Entry name here instead of IP Address so as tewiraoynfuture
issues that may crop up due to reconfiguring the IP Address of the appliance.

6. DNS Server Addresses: Please enter 1 or more IP Addresses of your DNS server in a comma separa
list.

7. DNS Search Suffix: Please enter the local DNS search ssféixailable within your local network.

8. Time Zone: Please select your local time zone from the drop down list.

9. Enabl e NTP: Please enable this option to avoi
synched and accurate.

10.Time Servers: This field eoes prepopulated with some public time servers. You can choose to enter
your own comma separated list of time servers as well. These can be entered as IP Addresses and/or
DNS entry names.

On fiSave Changeso all these configuration fields
Address correctly, the browser will redirect you to your new IP Address based URL. This initial Appliance
Network Configuration page is only availalon first run and will not be available subsequently.

I n addition to using the browser based interface
configured through the console.
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242 Configure StratusphereE Hub using the Consol e

IfDHCPisnotaai | abl e on the | ocal subnet, then you can
Open up the console to the StratusphereE Hub on
XenCenter or XenServer. Once opened, use the following defadkntials to log in:

User ID: ssconsole

Password: sspassword

Here is a list of commands to configure the appliance:

set management ip <static.ip.address>

set management netmask <network.mask>

set management default gateway ip <default.gateway.ip.addre Ss>

set dns server < dns. ip.address.1>[,< dns.i p. address. 2>, é] ]

set dns search <dns.suffix.1>[,<dns.suffix.2>,],
write

set system hostname <hostname>

set system hub dns name <hub.dns.or.ip>

set system mail relay server <mail.relay.ip.dns>

set system time zone <Continent/City>

set system time <yyyymmddhhmm>

set ntp server <time l. server.ip.dns>[,<time2.server.ip.dr
set ssh ssconsole on

set ssh on

write

set ntp on

write

exit

These commands are used to configure -@wordigure the appliance if iteeds to change its IP Address or a
new time server etc.wiMak ecsmmand olue fexree ud xi ttihreg At
saves the changes made so far.

25 StratusphereE Database Appliance

The Stratuspher eE Dateamaestei,0p QD Kegsmepat backsto thies e d  w h
StratusphereE Hub using the default callback fre
database from the StratusphereE Hub 4.8.x to cre
NOTE: Please upgrade the StratusphereE Hub to t he

Database Appliance

The process begins with importing the Stratusphe
Download site. Once importedonfigure the Database Appliance as a statically addressed virtual appliance.
The user must then copy a script to the Stratusp
external database. It exports the database into a backup filawsdlswn the database service on the
StratusphereE Hub. It then transfers this file t
Database Appliance, run a similar script to accept and restore the database backup file, enable services, anc
configure communication services between the Str
the two appliances can communicate with each other and are now configured for enhanced performance and
scalability. For detailed instructions pleasefrer t o t he ALwL. Stratusphere. |
document.
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251 Installing StratusphereE Database Appliance (VMware VS|

The StratusphereE Database Appliance can be i mpo
Liquidware Labs web siteTo do this, open the VMware vSphere Client and connect to your target VMware
vCenter host. I n the vSphere Client, select Fil

Stratusphere Database virtual appliance (OVF) that is listed on the Ligaitafas product download page.
Complete the appliance install wizard by accepting the evaluation license terms, providing the name, selectin
the host, data store, and network port. The virtual appliance will then automatically be downloaded and
installed

r@ Deploy OVF Template o | E S

-

Source
Select the source location.

Deploy from a file or URL

Browse, .,

Enter & URL to download and install the OVF package from the Internet, or
specify a location accessible from your computer, such as a local hard drive, a
netwark share, or a CO/DVD drive.

Help | < Back | Mext = I Cancel

A

e

252 Configure StratusphereE Database Appliance

Liquidware Labs recommends hosting the Stratusph
virtual switch, and same port group as the Sdstr at
communication response time between the Hub and the Database for high performance and scalability. Plea
ensure that there are significant CPU/Memory/lIO resources available on the host as these are major server ¢
virtual machines. After downloadn g t he StratusphereE Database Appl
Memory,set the required amount of disk space on the second disk (default is 20@Bnnect the NIC to the
same vVvirtual net work switch and port group as th
the console of the virtual machine to start the configuration of the appliimeelatabase appliance includes a
wizard for configuring the databa that will prompt for required information. If you wish to use the default
value for any setting you may do so by pressing the Enter key to move directly to the next setting. The wizarc
will ask for:

1. Current Value of Hostname:

2. Do you want to use DHCP (M)? If you choose No, it will prompt for static IP Address. Liquidware

Labs recommends using static IP Addresses.
3. What Address IP do you want to use?

© 2010 Liquidware Labs Pagel2



What Netmask do you want to use?

What is the default gateway?

What Primary DNS server do you want to use?
What Secondary DNS Server do you want to use?
What Tertiary DNS Server do you want to use?
Enable the NTP Time Server Service [Yes]?

10 What NTP Time Server do you want to use?

©ONOOA

This is an example of a completed configuration. Please note that namesadddes3es will vary according

to your environment.
@dh_l]?l 1 on esx5.trustednetwork.biz
Fil= View WM

= 00| B

Do you want to save this

To release cursor, press CTRL + ALT

conf iguration (Writes/EditsAbort/Quit- Nos#) 7 _

Save your configuration using the Awriteo comman
database.
@db_ﬂ?l 1 on esx5.trustednetwork.biz
File Wiew WM
m|p &8 @& Bl &
localhost. localdomain
(pid 3844) is running...
7:45:28 up 22 min, B users, load aueraqe B.86, B.81, B
total, : free
total,
y IP Address
WY Login to Console JRA Pl This Screen_
© 2010 Liquidware Labs Pagel3



The StratusphereE Dat abase Appl i anabaseifrantheot conf
StratusphereE Hub.

253 Transfer Database from StratusphereE Hub to Database A|]

Log in to the consoles of the StratusphereE Hub
Keep these two console windows héxeach other as instructions need to be executed on both these appliance
during the transfer.
SwitchtoSt r at usphereE Database Appliance Consol e
1. Log in to the console of the StratusphereE Da
2. Topreparethe Strasup her e E Hub for transferring its dat a
do so, execute the following command:

$ scp /opt/lwl/bin/ext.preparehub.sh friend@ <Huh IP . DNS>/home/friend/
The command will prompt whether to connect, accept keys and ask for a password. Use the
default fAsspasswordo. This script is now c

the Hub and execute it.

SwitchtoSt r at u s lHub Appliaree Console
1. Login to the consol e
2. We now need to stop

move it over to the

of the StratusphereE Hub |
the StratusphereE Hub App
Stratuspher eEmnlaradt abase Ap

$ /home/friend/ext.preparehub.sh

Important: Oncethe files aremoved over, this command wpthuse omwvait for you to execute

the corresponding commaielow by switching consolesn t he Str atusphere
Appliance DO NOT ENTER fAyeso0o just yet

The command will display status messages for stopping services etc. and will then prompt the
user for the I P or DNS of the Stratusphere
prompt whether to connect, accept keys and ask for a password. Use thie defiagl s p a s s w C
The database is now stopped and backed up to a file which has been transferred over to the
StratusphereE Database Appliance. The comm
on the Database Appliance below.

SwitchtoSt r at uspher eE Database Appliance Consol e
1. Execute the following command:

$ /opt/lwl/bin/ext.preparedb.sh

The command will now start restoring the database backup file copied over from the
StratusphereE Hub Appl i ance. ajtdke asigreficadtat a b a
amount of time. Once completed, the command will display the following message:

I DT OOET ¢ AAOAAAOGAATE
Thedatabasé¢ransfer and restoqgocedure imow complete.

SwitchtoSt r at u s lub Appleree Console
1. The StratusphereE Hub console wild.l be waiting
Appliance command finished successfully. Now
2 Just in case you entered fAYeso pr e mampketngthey (i
Strat us phe eetepdeailt.sh b @@nenand), please log into the console of the
StratusphereE Hub Appliance using ssconsole/s
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254 Complete StratusphereE Database Appliance configurati ol

Oncet he procedure is complete please verify the in
the Administration section using ssadmin/sspassword credentials. Navigate to the Hub Administration > Data
Retention > Status tab and verifythefsep ace avail able based on the cor

Database Appliancd@he database transfer and restore procedure is now complete. If you see any other
messages or errors please confagipot@LiguidwarelLabs.com

2.6 [Optional] Setup User Groups and Machine Groups

Now that you are logged into the Administration module, the first thing to consider is whether you will be
defining any user groups or machine groups for your assessment. Yahowgg to setup groups if you have
distinct sets of users or desktops that you want to analyze separately during the assessment. These groups
not need to be setup prior to the assessment, however if you set them up prior you can immediately use the
groups as you proceed through later steps. Groups can be useful for production assessments especially in I
environments, but are optional for this evaluation.

Machine groups can be used to group desktops for assessment, for example by locatiepantimgdt. To
define machine groups, go to Inventory > Machines, select Groups, and then click the New button

@ LiquidwareLabs pont el Log out

Hub Administration Station Administration Event Log Licensing Configuration

| Machines | Users Applications Subnets

Machines Page 1 of 1 < Prev Next >
View: Individual Machines [ Groups
ol Name A Type 0S Version %"f‘i‘?"‘m Created On Last Contact
Showing 1 - 1 of 1 [¥] Page 1 of 1 [¥] < Prev Next =

Version: 4.7.0 Evaluation License for up to 5 desktops unti Mov 22, 2010 © 2010 Liguidware Labs, Inc
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Hub Administration Station Administration Event Log Licensing Configuration

| Machines | Users Applications Subnets

Machine Groups Page 1 of 1 < Prev Next >
View: Individual Machines | Groups

I Group Name A Description Count VM Directory Created On

& AD/LDAP Servers 0 members Mov 12, 2010 5:24:28 PM EST

[ CID Key Desktops 0 members Mov 12, 2010 5:24:28 PM EST

[ DHCP Servers 0 members Mov 12, 2010 5:24:28 PM EST

A DNS Servers 0 members Mov 12, 2010 5:24:28 PM EST

| Ermail Servers 0 members Mov 12, 2010 5:24:28 PM EST

[ Fila Servers 0 members Mov 12, 2010 5:24:28 PM EST

| FTP Servers 0 members Mov 12, 2010 3:24:28 PM EST

| MS SQL Servers 0 members Mov 12, 2010 5:24:28 PM EST

[ MNTP Servers 0 members Mov 12, 2010 5:24:28 PM EST

[ Stratusphere Network Stations 0 members Mov 12, 2010 5:24:28 PM EST

& Web Servers 0 members Mov 12, 2010 5:24:28 PM EST

Showing 1 - 11 of 11 [¥] Page 1 of 1 [ < Prev Mext =

Version: 4.7.0 Ewvaluation License for up to 5 desktops until Nov 22, 2010 © 2010 Liguidware Labs, Inc

@ LiquidwareLabs pon 1o | Loa ous

Hub Administration Station Administration Event Log Licensing Configuration

| Machines | Users Applications Subnets

Create Machine Group

Group Properties

*Name: MNew Machine Group

Description! The first machine group or department or location]

(’ Create Machine Group n Cancel
rl

Version: 4.7.0 Ewvaluation License for up to 5 desktops until Nov 22, 2010 © 2010 Liguidware Labs, Inc

User groups can be similarly created by hand by going to Inventory > Users, selecting Groups, and then click
on the New buttonWith user groups you also have the choice to import groups from your Active Directory or
LDAP, or from a file. For this assessment, if you want to setup user groups either create them manually, or
import from a file by going to Hub Administration > Useiré&ztories, and select Import From CSV File from
under the Local Directory. Information on the file formats for user groups and users can be found there.
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l Hub Administration Station Administration Inventory Event Log Licensing Configuration
Data Retention Connector ID Keys ProfileUnity Agents VM Directorias UUser Directorias Backup & Restore

Directories

MNew Directory | Click the directories below for more options.

¥ Local Directory (Policy Center)
Status Auto-Registration Impaort From CSV File

Groups file (CSW):

Group file format
Each line of file has the following format:

[group-name],[user-namel;user-namez2;...;user-namen]

Users file (CSV): Browse_

Each line of file has the following format:
[user-name],[role(user or administrator)],[email-address], [active(true or false)],[group-
namel;... ;group-nameM]

Station Policies: [ Update policies on Network Stations after import
Note: Policies will not be updated if the administrator has made any changes since the last
update

Version: 4.7.0 Evaluation License for up to 5 desktops unti Nov 22, 2010 © 2010 Liguidware Labs, Inc

2.7 Review Data Collection Settings

The next step is to review your data collection settiybile logged in to the Administration module, click on
Hub Administration > Connector ID Keys. The first thing you will see is a set of Properties that control the da
collection functions. Some notes on key properties (and suggested defaults aerirskot below):

- Callback Frequency the frequency that the Connector ID Key software agents (discussed in next
section) will send collected data back to the Hub; in environments where a single Hub is monitoring
many desktops (more than 500) then you wiht to be careful about setting the frequency too low,
since it will increase the network traffic (about 30K to the Hub on each callback) and the load on the
Hub along with the amount of disk space used; note that detailed sizing guidelines and Hub tunin
recommendations can be obtained from Liquidware Labs customer support

- Enable Machine Inspectidnindicates that configuration and usage data should be gathered from user
desktops

- Inspection Sample Intervalthe frequency at which the Connector ID Kefjtware gathers data on
application and user activity and resource consumption on the user desktop; if the Callback Frequency
15 minutes or less, then it is recommended that you set the sample interval to 1 or 2 minutes, for longe
callback frequenciei$ is good to use sample interval of 5 minutes

- Inspect (All the Time, or Only when user logged bispecifies whether application activity should be
inspected all the time, or only when user logged on if you want to focus strictly on user activity

- File/Fdder Size and Counisspecify folders and document types, will cause the Connector ID Keys to
gather data on the number of files and total file size for each folder or file type specified

- Automatically uninstall Connector ID Key softwardor Keys that ee installed locally on user desktops
(more on install in next section) this setting allows you to specify number of days after which the
software agents on user desktops should Adiss
takes effect as soas the CID Keys download their settings at the next callback interval. 0 = NEVER.
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- Enable Connector ID for TCP Connectianthis allows more accurate tracking of the network latency
between the user desktop and the Hub during the assessment, recomiméamiaglthis on

& LiquidwareLabs print | Help | Log out

[ Hub Administration Station Administration Inventory Event Log Licensing Configuration
Data Retention | Connector ID Keys | ProfileUnity Agents VM Directories User Directories Backup & Restore

Connector ID Key Software Administration
| Connector ID Key Properties | Connector ID Key Software

These properties are used when you create a new machine and are also applied to all existing Connector ID Keys installed on configured machines. Properties are
updated on each Connector ID Key only after it calls back to the Stratusphere Hub. You can set Connector ID Key properties for individual machines in Inventory =
Machines .

Properties

Callback Frequency: 1 hours =

Set how often the Connector ID Key should call back to the Stratusphere Hub. Update interval must be 5 minutes or greater.

Enable Machine Inspection.

Use this option to enable user and application activity inspection with data returned whenever the Connector ID Key calls back
to Stratusphere.

Inspection sample interval : 5 minutes.
The sample interval can be as low as 1 minute however this number should
be lowered cautiously.

Inspect: @ All the time when machine is running.
) Only when user is logged on.

Get size and file count for folders © My Documents, Desktop

Comma separated list of folders. Example: My Documents, M:\UserData,
%USERPROFILE%\Documents, 2%HOMESHAREY.

Get size and file count for file types : esxe, pst, mp3, pdf, txt, doc, docx, ppL,
pptx, xl1s, xlsx

Comma separated list of extensions. Example: doc, doc, ppt
Conduct remote network latency tests :

Optionally enter up to five IP addresses, separated by commas, that will be
used to conduct network performance tests from each machine.

[] Automatically update Connector ID Keys when new software versions are installed in the Stratusphere Hub.

[] Automatically uninstall Connector ID Key software.
Use this option to remove Connector ID Keys after a defined interval from install date.

Properties that only apply to advanced versions

Enable Connector ID for TCP connections.
Use this option to monitor or control TCP connections.

[] Enable Connector ID for UDP connections.
Use this option to monitor or control UDP connections.
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2.8 Distribute Connector ID Keys to Target Desktops

To begincapturing metrics within your target desktop environmgo will need to deploy the Connector ID
Key software to the target desktops. You can find the software by loggioghe Administration module,
proceed to Hub Administration > Connector ID Keys and click on the Software tab. Liquidware Labs
recommends using the Standard CID Key installer that can be used interactively and distributed directly to
desktops.

Connectr ID Keys are small footprint (less than 3 MB) and run invisibly with minimal performance impact on
the end user desktops. By default when using the Standard version, they will be installed in a folder named
Liquidware Lab¥Connector ID in the Programl€s folder. The Windows Standard installer has information
that all ows it to c a laidrebister dutorhatically. TI®y coramunicatp $eeurely &ith H
your Hub over TCP and UDP on port 5501.

Note that the @l oc ayscanleinstdlled anachi@es (physicalividual | D Ke
desktops/servershat will be used remote or offline, as long as there are certain times (including initial
installation) when the machines are connected to the network and can reach the IP addressaithBNS
Stratusphere HubData collection will continue while the machines are offline, and wwaaveels of
information can be stored locally until the next time the machine is connected to the network.

@ LiquidwareLabs print  Help | Loa ut

l Hub Administration Station Administration Inventory Event Log Licensing Configuration
Data Retention Connector ID Keys ProfileUnity Agents VM Directories User Directories Backup & Restore

Connector ID Key Software Administration
Connector ID' Key Properties Connector ID Key Software

Recommended Versions
Connector ID Key Software Version Details

This is the most used version for 32/64 bit Windows. Use this for interactive installs and with any software distribution tool

‘uﬁ.fini?'.'.rs - Stancffd Version 4.7.0-1 that can handle EXE fils.

Version: 4.7.0 Evaluation License for up to 5 desktops unti Mov 22, 2010 © 2010 Liguidware Labs, Inc

If you are interested in other versiongioé Connector ID Key for Linux operating systems or using the
Net work or Advanced versions of the CID Key then
page and you will see all the remaining versions.

The local install EXE can be pusheasing SMS or any other standard software distribution tih@an also be
embedded into the master image of the virtual desKio@.command line to install the Connector ID Key for
Windows Standard version is:

Install - connectorlID -Key-4 7 0-winStandarde xe / q [ HUBADDRIERSoS=0hub
dns-nameo] [ MACHI NEGROU@éup omeancehd In e[ USERGR-@tdbp=0us er
name o]

The Network Shared install can simply bezipped onto a network server in a shared folder. The command
line to start the Network shared ConnediKey is:

netcid start <o0onet woid Kkfolder -path 6 >[-ha fihub-ip -or-dns-named][ -mg
fimachine - group - nameo] [-ug Auser - group - nameo]

The command line to stop the Network shared Connector ID Key is:

netcid st op <0netidwdader -pat ho>
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If you need to pusbut the CID Key using Active Directory Group Policy then you can also download the AD
GPO version of the installer which is an MSI along with the Group Policy template that can be used for
software installation. Detailed instructions for both types oailhstin be found in the Appendix of this
document.

To confirm that the Connector ID Keys have been successfully installed on the desktops or servers, and that
they are reporting data back to the Stratusphere Hub, login to the Administration produesnoodybur
Stratusphere Hub, and go to Inventory > Machines. The machines with Connector ID Keys running should
automatically show up registered in the inventory list and you should be able to see their Last Contact Date
updating as they make their regutallbacks to send data to the Hub. If machines are not showing up properly
in the list, review your installation steps, that the machine is connected to network (for registration) and can
reach the Hub (using TCP and UDP on port 5501).

@ LiquidwareLabs Print | Help | Loa Out
Hub Administration Station Administration Inventory
i Machines Users Applications Subnets
Machines Page 1 of 8 < Prev Mext >
View: Individual Machines | Groups
[] Name 4 Type OS Version mz:‘g:nm Last Contact
] | apollozk3-01 | Virtual g;irgéuﬁ[RJ windows(R) Server 2003, Standard Edition, Service QFI;ETEN Eg_f_la, 2009 5:52:47 PM IJEaSnTEE, 2010 10:50:58 AM
[ apolo2k3-02 Virtual Ldzi‘ccrfzoft[li) Windows(R) Server 2003, Standard Edition, Service ids.vazrjfed [E}S_T_ 18, 2009 10:23:01 PM IJEaSnTEZ, 2010 10:54:11 AM
[ | apolo2k3-03 | Virtual E'Izi‘ccrkoéoft[R] Windows(R) Server 2003, Standard Edition, Service :‘.cIS\.tiljlced Es_f_la, 2009 10:40:35 PM Eggr 13, 2010 3:09:17 PM
E] apolozk3-04 Virtual Ldii'ccrﬁszoft[R) windows(R) Server 2003, Standard Edition, Service :dﬁrjlced [E}S_T_ 18, 2009 10:55:38 PM E;gr 13, 2010 3:06:12 PM
[ apolo2k3-05 Virtual I';Ei‘ccrkos;ﬂ:[R] Windows(R) Server 2003, Standard Edition, Service Q.IEIS\.:il?fed Es_f_ls, 2009 11:08:03 PM E;gr 13, 2010 3:03:39 PM

2.9 [Optional] Setup Import from vCenter for Host Statistics

To get performance statistics on the virtual hosts, such as CPU Ready and Memory Swap Rate statistics, it i
necessary to configure the Stratusphere Hub to connect to your vCenter (or to multiple yC€&hiers
capability is only available for VMware in 4.6, future versions will support XenServer and XenCenter as well.

To configure the connection, login to the Administration section of your Stratusphere Hub. Navigate to the VI
Directories tab, and clicon the Create New VM Directory button (do this once for each vCenter you want to
connect to). Specify the connection information, then Save Changes.
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a - -
@ LiquidwareLabs print b Lon Out

Audit Data Connector 1D Keys ProfieUnity Agents MNetwiork Stations | WM Directories | User Directoties Backup & Restore

VM Directories

(E_:reate e Wi Diren:tory_b

¥ wsphere

Status | Properties | Import from %M Directary Schedule Irmport Delete

*Mame: |vsphere |

Type:

*Fully Qualified Mame: |vsphere.tntqa.cum |

*Service Account Name: |irinﬁ |
Mote: Provide the service account login information for the WM directory, You may
setup a special access account within your Y directory for Liquidware Labs to
import appropriate machine and group information.

Service Ancount Passwaord: | |

Fart:

Security: Use secure connection

*Statistics import interval:
Specify the time interval used to import host performance statistics,
‘ Sawe Changes .

To allow Stratusphere to initialize the information for your hosts, you also need to do an I@imkn
Import from VM Directory, and click the Import button. Stratusphere will import the Host definitions and the
information about the VMs assigned to each virtual host.

[ CMDB Administration Inventory Event Log Licensing

Ludit Data Connectar ID Keys ProfieUnity Agents Metwiork Stations | WM Directories | User Directories Backup & Restore

VM Directories

’ Create Mew M Directary ]

¥ wsphere

Status Properties Import from WM Directory Schedule Import Delete

Machine groups: Include machine groups during import

® Use Folders for Machine Groups
O Use Resource Pools for Machine Groups

Station Policies; [ Update policies on Metwork Stations after irmport

2.10 [Optional] Install Network Stations on Virtual Hosts

If you want to cafure details on network traffic, bandwidth, latency, and server response times for your virtual
desktops, then you can also deploy Stratusphere Network Stations onto the virtual hosts where the virtual
desktops run. The Network Stations are virtual appéa, very similar to the Stratusphere Hub with similar
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steps for installation. The Network Stations do not have their own brawsegace;however, they are

managed via the console or through the Stratusphere Hub. And because the Network Statnamstavilthe

traffic for the virtual desktops on each host, they must be connected to a promiscuous port group (mirror port
on the host virtual switch. One Network Station can monitor all the network traffic on an indwirtugl

switch on a singl@ost. The details of traffic to be monitored are set within the Stratusphere Hub administratio
interface.

Once a Network Station is installed and started, it will automatically register with the Stratusphere Hub.

To install a Network Station, you witlieed toadownload the OVF or XVA .zip from Liquidware Labs web site
The Network Station has 2 NICs. NIC 1 is the management port that will accept the static IP Address of the
appliance and NIC 2 is the promiscuous NIC that will be used to monitor netarmmkations. e sections

below describe how to configure the promiscuous port in VMware or XenServestefiseto configure a

Net work Station are al most exactly the same as t
Network Stationwil pr ompt the wuser for information regard
administrative credentials.

The summary of steps to install a Network Station is:
- Configure a promiscuous port on the target virtual host(s) as described below
- Import the OVFor XVA (download from Liquidware Labs) as described in section above
- Connect the second port of the Network Station to the promiscuous port
- Power on the Network Station
- Run the console Quickstart, speci fyidalspspedifyeng St
the connection information to connect to the Stratusphere Hub

2.10.1 Configuring Network Monitoring on VMware Virtual Switch

To enable detailed network performance monitoring, the Network Station virtual appliance has a second port
that must beonnected to a promiscuous port group on your virtual host network switch (allowing it to monitor
the network packets that are traveling to and from each of the virtual deskttgos)are the steps to configure
a virtual switch:
1. To configure the virtual switch on a target host, for VMware open the VMware Infrastructure (VI)
Client for the target host, select the Host and go to Configuration > Networking, and click on Properties

[ cesxws. tntatl.internal - Yiware Infrastructure Client

File Edit VWiew Inventory Administration Plugins Help

Inventary Administration
4

« B | 5 &

= [0 |cESHws.trkatlinkernal CESXws.tntatlinternal VMware ESX Server 3i, 3.5.0, 110271
5 JaDevHub
1 PC-PKURRx64 Getting Started ' Summary ' Vitual Machines esource Allocation ' Performance  JERGTREGN |serd
I3 stratusphere_hub Networking
3 vEirtReport

Eh vDKi01
3 vDKhare Virtual Switch: wSwitch Remove.. 4 Propetties...
&

vJAlexander Wittual Machine Port Group | Phsical Adapters
Eh vTRohrer Stratusphere Manitar o vmnicd 1000 Full 3
B 2 virtual machineds) | YLAN ID Al

JaDevHub
skratusphere_hub
irtual Maching Port Group

o0z
El |3 virtual machine(s) | ¥LAM ID 202

wBirtRepart

JaDevHub
stratusphere_hub
Wirtual Machine Port Group

1 10.0.5.x
B 5 wvirtual machineds) | YLAMN ID S

PC-PRURRxE4
vDkhare
wTRohrer
wDK101

2. Set all existing préduction port groups on theual switch tofiRejecd Promiscuous Mode
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3. Now editthe virtual switchitself and set it tdiAccepd Promiscuous Mode

[ vSwitchO Pro perties

Parts ] MNetwork Adapters ]
wSwitch Properties ~
Configuration Surmmary =
@_V_Switch = Por£s_:> | Murmber of Ports: 56
Stratusphers Monitor Virtual Machine ..,
& 10.10.2x wirtual Machine ... Biefenl: Falliics
@ 1005z Wirkual Machine ... )
g W Metwork, wirtual Machine ... Securit
g Management Metwork, WMotion and IP ... Pramiscuaus Mode: ACCEp
MAC Address Changes: Accepk
Forged Transmits: Accept
Traffic Shaping
Average Bandwidth: IS
Peak Bandwidth: IS
Burst Size: IS
Failover and Load Balancing
Load Balancing: Part ID
Metwork Failure Detection: Link. Status only
Motify Switches: Yes
Failback: Yes
h Active Adapters: wmnicO T
add... Edt... | | ,
Standby Adapters: MNone v
| Close | Help |

4. Nowadd a new Port Group andt wi | | AccepdBromistuous Mad&oin the virtual switch
If there are multiple VLANSs on th switch and you want to monitor only 1 provide that VLAN ID while
configuring this promiscuous port group. If you want to monitor all the VLANS on this virtual switch,
then set the VLAN ID to 4095. It will provide this promiscuous port group with netemmkections
across all VLANs on that switch.

| ywSwitchO Propertie

Parts ] MNetwork Adapters ]

Configuration Summary [ Strat usphere Monitor Properties

£t wswicch 56 Ports

Stratusphere Monitor — Wirbual Maching™>s, General  Securty l Traffic Shaping] MIC Teaming]
g 100ER wEual Machine ...

Puolicy Exceptions

@ 10.0.5x Wirkual Machine ...
% W Mebwork virtual Machine .. Fromiscuous Mode: ,7 |Accept -

Management Netwo,,, YMotion and IP ... MAL Address thange:: = :

Forged Transmits: - |

Lelled

Once your virtual switch is configured, you are ready to download and install the Network Station virtual
appliance onto your VMware host.
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2.10.2 Configuring Network Monitoring on VMware Distributed Switch

Hereare steps to create a promiscuous port group on VMware virtual Distributed Switch.

1. Add a new port group to the virtual distributed switch.
— | e e S T T T —

[‘..3] vsphere.tntqa.com - \rSpherE Client
— ——— W i W —— o

File Edit Wiew Inventory Administration Plug-ins Help

ﬁ |Eﬁ Home P gF Inventory P @ Networking

B Pro10.10.2.x
B Pro10.10.3x

on vCenter. Using the Networking view, you can create
and manage networking with vhetwork Distributed

v H
SN phere.tnl'qa.mm vsphere.tntga.com VMware vCenter Server, 4.0.0, 208111
QA
= VDI el-mdl ol \yd-lal. Datacenters | Virtual Machines | Hosts | Metworks | Tasks & Events | Alarms | Pg
~ § 10.10.2x
£ 10.103x What is the Networks view?
i 10.10.6.x vNetwork Distribu
B Cisco Pix This view displays the set of networking objects available

® Poct groups &=
. N

% g’ﬂ ;ﬁ-;&ﬁr:‘ Switches and view networking with Standard Switches
o configuration. =
E ﬂ ‘I“IIJM vmi@

§el  AddHost.. Ctrl+H bypes of network architecture.
§&& New Port Group... brk Distributed Switches manages
@  Edit Settings... st networking at the datacenter
Migrate Virtual Machine Networking... with Stand_ard Switches manages
st networking at the host level. 7

|

vNetwork Standar

Port groups

Alarm *
e 1

1 Remove

Recent Tasks Rename

Name | Target Status | Details | Initiated by | vCenter Server Requested 5t
' i |

& Tasks @ Mlarms |License Period: £62 days rer

e
2. Give it an appropriate name ¥aucdnleas thefdéaNumkdero r o

of Ports atl28 or reduce it to the number of hosts you have this distributed switohl@ncluster
Select théiVLAN Trunkingd optionfor VLAN Type and enter @094VLAN trunk range to get all
VLAN traffic or you can be more specifitased on VLANs you want to mior.

= | B S |

Y
(&) Create Distributed Virtual Port Group

Properties
How do you want to identify this network?

Properties — Properties
Ready to Complete Name: IvaortGroupPro
Number of Ports: |24 3:
VLAN type: I'M'LAN Trunking ;I
VLAM trunk range: (e.g. 1-4,10-21)
|04094{
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3.0nce created, right click and select AEdit Se

= | YOI | et EE G Summary | Porks | Virtual Machines | Hosts .| Tasks & Eveni[ 2
® 10.10.2.x a]
10.10.3.x . = .
% FETE What is a distributed virtual port group?
8. Cisco Pix A distributed virtual port group is a port group associated
£ Pro10.10.2. with a vNetwork Distributed Switch and specifies port
$ Fro10.10.3.x configuration options for each member port. Distributed
&, Pro (D106, virtual port groups define how a connection is made
&, FroMyLA through the vNetwork Distributed Switch to the network.
= @ dvSwitch

B dvSwitch-D¥Uplinks-
l?:l dvPortGroup
£, |dvPortGpounben

Alarm » [ Ll
l Edit Settings... IE this distributed virtual port group
Delete
4. Navigate to Policies > Security and change th
o]
areral —Policies
Policies Security
Traffic Shaping Promiscuous Mode: I Accept v
YLAN ‘ MAC Address Changes: _
Teaming and Failover Reject
Miscellaneous Forged T its:
Sidoancad orged Transmits IAccept _:I

5. Now Navigate to Advanced andamncd ialkl cowm oaivEerirti dOe
Porto and ASecurity Policyo.
(! dvPortGroupPro Settings i = Il'_'llz
Advanced
General
Palicies IV Override port policies Edit Override Settings...
Security : ;
Traffic Shaping I™ Live port maving
VLAN —
Teaming an Port Group DOverride Settings - _x_l
Miscellaneo
Advanced Select individual port setting overrides.
— Override Settings
Settings Overrides Allowed?
Block Port: “ ves { No
Traffic Shapina: " Yes ¢ Mo
Yendor Configuration: " Ves * No
YLAN:  Yes ¢ no
DYUplink Teaming: " Yes % Mo
Security Policy: * ves ¢ No

Help | I oK I Cancel
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6. The promiscuous port group will wadbe available on each host that has this virtual distributed switch.
Configure a Network Station on each Host and connect its Network Adaptor 1 to a pprivftoa
static I P that can communicate with the Strat
newly created promiscuous port group.

2.10.3 Configuring Network Monitoring on XenServer

To enable the network performance monitoring, the Network &tairtual appliance has a second port that

must be configured in promiscuous mode on your virtual host network switch (allowing it to monitor the
network packets that are traveling to and from each virtual desktop). After importing the XenServer XVA, yoL
wi || need to configure the network monitoring.
promiscuous mode will not affect any other VMs on the Host. For XenServer, the first step is to access the
console for the XenServer host. Click tve Host in the XenCenter Client and open the console.

X XenCenter, E@E

File  ¥iew Pool Server WM Storage Templates Tools  Window  Help

OE‘“" " E A 4dd New Server )| MewPool = New Storage [ | New it @ushut Down (&Y Reboot (| ' Mo System Alerts

Shaw: | Server Yiew

= Search | General | Storage || Mebwork | NICs | Console | Performance | Logs

=l Eig labxsot
"0 =En_hub labxus01 server console
= DVD drives

= Local storage o
@ Local Storage
= Removable storage

[ scale @t Undock {al+5hift-+U) ] Fullscreen (Chrl+AlL) l
I n the XenServer console, you wil/ need t ofilpesrtfoo

command to find the appropriate target and the appropriate UUID, and at the erfu stEpamu can use the
fiparaml i st 06 command to see that the changes were s:
complete the UUIDs if you type in the first 3 characters and then hit tab.

At the console command line, perform the followstgps:

1. Modi fy the promiscuous setting for the Hubds
xe vif-list vm-namelabel=xen_hub
xe vif-paramset uuid=<uuiebf-vif>otherc onf i g: pr omi scuous=0trueo
xe vif-paramlist uuid=<uuidof-vif>

2. Modify the promiscuous setting forthe selves p hy si c al i nterface
xe pif-list networknamelabel=ethO
xe pif-paramset uuid=<uuiebf-pif>otherc onf i g: pr omi scuous=0trueo
xe pif-paramlist uuid=<uuidof-pif>

3. Modify the promiscuous setting for the host virtual network switch

© 2010 Liquidware Labs Page26



xe networklist namelabel=Poolwide network associated with ethO
xe networkparamset uuid=<uuiebf-network>othelt onf i g: pr omi scuous
xe networkparamlist uuid=<uuidof-network>

X XenCenter E]@

File  Wiew Pool  Server %M Storage  Templates  Tools  window  Help
OEack - ?_%Add Mew Server ?f_ Mew Poal =4 New Storage |New W @ShutDown ﬁReboot L 4 Mo System Alerts
Showe | Server Vigw
= gfanCenter Search | General | Storage || Metwork | NICs | Console | Performance || Logs
= g labxs01
% xen_hub
5 VD cirives T G U S T TR T e S e D O TEC e
={ Local storage )
@ Local Storage 14 xe 011‘ paran— llst uu id=5a94b040-d148-2526-e268-8742fe3cclc
= Removable storage i 5a94b040-d148-2526-e268-8742fe3cclcd
un-uuid € Rl]): 6601a515-ae42-85d9-65c3-f3474cf£8b03
um-name—-label ( RO)Y: xen_hub
allowed-operations (SROJ: attach
current-operations (SRO):
device ( ROJ: 1
MAC ( RD): 2e:c4:95:ea:fb:71
MAC-autogenerated ( RD): false
MTU ¢ RO): 1500
currently-attached ( RO): false
gos_algorithm_type ¢ RW:
gos_algorithm_params (MRW):
gos_supported—algorithms (SRO):
other—-config (MRW): promiscuous: true
net wid ( RD): 7cfe3420-63 Gf9-1164-56eb0faf1522
network-name-label ¢ RD): Pool-wide network associated with eth®
io_read_kbs ( RO): <unknown>
write_kbs ( RDJ: <unknoun>
[root@labxs01 ™1t 2
[ scale £ | Undock (alt+shift+U l l Fullscreen (Crrl4+alty

The Network Station virtual appliance is how re&alype configured
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2104 Configure StratusphereE Network Station using the Cons:

The StratusphereE Network Station has two networ
static I P Address to communi cate o0V ereptomiscuonsgobriwo r
that plugs into the new port group created in the section above. It sniffs the traffic of this NIC and sends the d
to the StratusphereE Hub over the management por

Liguidware Labssite t o confi gure these NICs, right click o
Set t iSelegtshé appropriate network connection labels and assign them to each NIC.
&) Training5tationd.7.1 - Virtual Machine Properties | = | (=] ﬁ]
Hardware l Options ] ResolUrces ] Virtual Machine Version; 4

Device Status
[ Show All Devices Add... | Remove | r
Hardware Summary [¥ Connect at power on
Sl Memory 512 MB
o crus ! ) Adapter Type
|;| Video card Viden card Current adapter: Flexible
% CD/DVD Drive 1 COROM D
BB MNetwork adapter 1 (edite.. VM Metwork MAC Address
BB Network adapter 2 (edite.. VM Network Pro 00:50: 56:b8:00:b0
0 SCSI controller 0 L5I LogicParallel {* Automatic ™ Manual
&= Hard disk1 Virtual Disk
= Hard disk2 Virtual Disk Metwork Connection

Metwork label:

Help (04 | Cancel |

Once configured, power ON the appliance and open the console to the @poplia@ machine boot sequence
will be visible within the console. After it finishes booting, it will prompt the user to configure the appliance as

shown below.

Btarting tnt-backend-priwv: L
Btarting tntpolicy: L
Starting crond: [
Btarting netauditd: [
Btarting anacron: L
Btarting atd: L
Btarting jexec: [

Becurity warning: root password is still set to system default.
Becurity warning: friend password is still set to system default.
Security warning: ssconsole password is still set to system default.
Flease change passwords

ould you like to configure the appliance? [yes-nol _
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The user would need to have the following ready items ready to configure the Network Station:
Hostname

Static IP Address

Network Mask

Default Gateway IP Address

DNS Servers
StratusphereE Hubbo
.Admi ni strative <cre
Proceed as show below:

Security warning: friend password is still set to system default.
Security warning: ssconsole password is still set to system default.
Please change passwords
ould you like to configure the appliance? [yes-nol yes
ype ? for possible wvalues
fAippliance hostname [localhost.localdomainl: stationdl.lwl.corp
Appliance IP address [18.18.3.2541: 18.8.88.59
Appliance netmask [255.255.255.8]1: 255.255.254.8
Appliance default gateway IP address [18.18.3.11: 18.8.88.1
DNS Servers [1: 18.8.18.12,18.68.18.13
o auto-register the station enter the Hub address []1: demo.ligquidwarelabs.com
ub Admin account []1: ssadmin
ub Password [1: sspassword

NookrwhE

i als on the Stratuspher

urrent configuration:
zsystem hostname stationdl.1lwl.corp
management ip 18.8.868.59
management netmask Z£55.255.254.8
management default gateway 18.8.88.1
dns server 18.8.16.12,18.8.18.13
system hub address demo.ligquidwarelabs.com
system hub admin ssadmin
zystem hub password sspassword

ould you like to save this configuration? [yes-snol _

Once the user saves the configuration abtheeNetwork Station will save these settings, configure itself on the
net work and then register with the StratuspheretE
then provide a login prompt.dg the following default credentials to log in

User ID: ssconsole

Password: sspassword

Here is a list of commands to configure the appliance:

set dns search <dns.suffix.1>[,<dns.suffix.2>,],
set system timezone <Continent/City>

set ntp server <time 1. server.ip.dns>[,<time2.server.ip.dr
set ssh ssconsole on

set ssh on

write

set ntp on

write

exit

Theseconsolecommands are used to configure ccomfigure the appliancéf the appliance needs to be
reconfigur ed t hgeickstaste roO ccaonmmilashsdu.es u rhe Yiowite eOxommand e t
before exiting the console as that actually saves the changes madd ke fatwork Station willnow show
upunder the St r WebwWsAgnhinesiratioB prétucbudider Station Administration tilzan be
managed from t hmthdipomtoswardse b Ul fr o
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3 Diagnostics Prep 2: Learn the Basics of Stratusphere

This section provides an introduction to the key elements of the Stratusphere UX product. To log in to the
product, open your browser and go to https://[yadiual-appliance p-address], then select Stratusphere UX
from the Product drepdown, and enter the default username: ssadmin and password: sspassword.

€ LiquidwareLabs

Log In

Product | Stratusphere Ux

Licensed Products:

Domain | Local Directary
User name |ssadmin

Passward

Licensed To:

License Expires:
Desktop Limit:
Usger Lirit:

Stratusphere Fit — Assessmant and capaciy plamibg
Stratusphere UX — Diagnostics and service level assurance
ProfilelUnity — Lisar profile migration amd managemeartt

ProfileUnity Pro — Lser profile migration, managemert, and depiopmernt

frtegrity
bl

100
E)

3.1 Diagnostics Dashboard

The first thing you will see is the UX dashboard. This provides an overview of theotlatded along with
reakttime refreshing and driflown options. See the screenshot below for notes on the sections and usage.

Diagnostics Inventory Policy Administration

| Summary | Inspector Reports Alerts DI LIX Profile

Click to generate sumrmary
powerpaint report

Diagnostics Dashboard

v groups or time periods

Use filters to focus on specific

[ Generate Summary Report ]

Click to refresh page after

changing filters or widgets

S[ Fun Feport ] [ Clear Filter ]

Machine Group: [Type ta search. .

[x] V Average Over: ‘One hour

v

User Group: [Type to search...

CID Keys Reporting Interval: 10 minutes

7]

Hurmber of alerts in last 24 hours:

Refresh Every: M

Header shows key summary
info, click on link to view alerts

286 Audit data space: 29,2 % full

WOl LU v | Login Delay v | Host CPU Load v|
4 | 1 \; 16,7 1
3z Select widgets to display at each 16,62
position from the drop-down
2.4 16,54
1.6 0.4 16,45
0.8 0.2 1,38
[ 0 16,3
P Sl
- D A B
“Gond  Far  =oor e w10 eei
Inspect Inspect Inspect
Machine/User Counts v |CPU Cueue Depth b Host Memary Usage hd
H I 7 31.3
5.8 5.6 1,28
4.5 4.2 B1.27
3.4 2.8 E1.25
&8 1.4 B1.24
1 [ ——————__ e e e e 1,22
T Ty
5 ‘:_"' ‘:_\' ‘(" G Qﬁ" Q" Q"'
o > ¢

Machines Users

Inspect

Click the Inspect link on a widget
to drill-down to mare detailed data

bYW
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3.2 Inspector

Click on Diagnostics > Inspector, and you will find a list of interactive reports and graphs that you can use to
explore the diagnostics data. Use the eifopn at the top of the page to select the view and then click on the
Go button to move to that view. You can filter the data using controls at the top of the page, and dynamically
sort or drilkdown using contrig on the data table. Data can also be exported to PDF, XLS, and other formats.

Stratusphere’

Diagnostics Select \fiewf click Go to
change to View
Surmrnary Inspector f/ DI U¥ Profile

hachine Diagnostics Summarny ¥ JUSE filters to focus on

After changing filters click
here to refresh page

Use datetime filters to
focus on specific period

N

specific machines,
users of apps

¥ Last 60 Minutes (May 12, 2010 3:06:10 PM E 19 PM EDT) | & g all (no filter) [ Refresh Page | [ ClearFilter |
Machine / Group: [Type ta search.. v / Date Range: @& Standard O Custom Click link to export data to
User / Group: [Type to search... v Last 60 Minutes v file format such as POF,
o ¥L3, CEW or other
spplication: [Type to search.. v 1 Only When User Logged On

Hide Graphs | Export

YOI UX Trend

Machine Count

1 D—C /.u——o— s (O e, e :
01 1 Use page controls to move |

) forward, backward or change the
Click on colurn

number of items shown on page

Click dril-down button on headers to sort data [= caad Fair = poor |

Fow t_o drill down to maore \l w

detailed data Page 1 of 1 £ Prey MNext =

Unique Time In 0o (o PP Gooue Swich  Memory | Fat 0bs Quewe NetWark GG Comnects Graphics g YO 4
Avg.(s) Avg.s) Avg.  Avg. (f5) Avg. Avg. Avag. Avg.{ms)
[ nprocid-8 1 100 nfa nfa 0.43 - 277.83 99,54 31 1 ] ] nfa ] 43,53 u] Fair
[¥] naocid-s 1 100 nfa nfa 0.36 - 517.88 175.41 25.84 069 0O u] nfa u} 45,92 u} Fair
[ rnocid-s a u] nfa nfa 0.33 - 137 138.79 5 0s7 0o u] nfa u} 11.31 u} Fait
® nprodd2 1 100 nfa nfa 0,26 B8 2455 11274 22682 075 0 o nfa o Eed 0 Fair
[ rprocida 1 100 nfa nfa 0.2 BB 207 w532 413 076 o 0 nfa o 61.75 o |EEEE
[¥] nprocid-1 0 u] nfa nfa 0.26 184 160.83 84.33 741 062 0O u] nfa u} 11.89 u} -
Showing 1 - 6 of 6 ¥ Page 1of 1 [¥] < Prev Mext =
3.3 Reports

Click on Diagnostics > Reports and you will find the list of previously generated reports on your Hub (if you
have just deployed there may not be any in thg lishe full list of available reports can be found by clicking

on the Report Library. In the Report Library, you can select and dynamically run individual reports, and you
can Edit them to setp schedules. Note that all reports are customizable dsrgpen source BIRT Report
Designer, and you can add custom reports to the library as well (for more information on report customizatior
as well as how to query the Hub database directly from Excel or other tools, contact Liquidware Labs support
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Stratusphere’ Print | Help Lo Out

Diagnostics Inventory Policy Administration
SUMmary Inspector Reports Blerts WOI L% Profile
Reports F‘J Categary: Degktgp Fedormance w Page 1 of 1 = Prev Mext =
~ Filter reports by the time
Start Date: |05/1110 _E 4:34 Phd kf) they were run, click
- Refresh “iew hutton after I !
(1 L To wiew all the available
End Date: |05/12/10 4 [5. ® .
no o s 2:34PM - changing time reports, edit schedules, or run
Date = mm/ddyyyy; Time = hhimm, hhimm am, or bhimm pm individual reports, click here
\/ Refresh Yiew
Selected 1: [ View Report | [ Delste | [ Unselect View Report Library
[] Run Date ¥ Category Report Status Criteria
v

, 2010 10:45:00 PM  Desktop Period 5/10/10 10:45 PM to 5{11/10 10:45 PM,

S S, Machines with High Page Faults  Complete Threshald 10,000
Click on row to select report to top
view then click View Report button [rmance WDI LI by User Complete Period 5/10/10 10:30 PM to 5/11,/10 10:30 PM
Ay 11, 2010 100000 PM Desktap ) ) , ,
IF] EDT S WOT L by Maching Complete Petiod 5/10f10 10:00 PM to 51110 10:00 PM
May 11, 2010 2:00:00 PM Desktop . . ] ) Falled to generate . ) )
i EDT . Machines with High Disk TOPS repart Period 510710 9:00 PM to 511,10 9:00 PM
May 11, 2010 8:30:00 FM  Desktop ) , ,
IF] EDT S Cverall SaM Performance Complete Period 51010 2:30 PM to 5f11,/10 2:30 PM
May 11, 2010 2:320:00 PM Desktop ol f . . .
] EDT . SAN Activity By Machine Complete Period 5/10/10 2:30 PM to 5/11/10 8:30 PM
Stratusphere’ Print Help = Log Out

Diaghostics Inventory Policy Administration

lIse Edit button to change report
default parameters, output format, set
schedule or generate alert

SUMmmary Inspector Reports Alerts WOI X Profile

Page 1 of 1 = Prev Mext =

Report Library category: | Desktop Perfarma

New | Selected 1: [ Search Archives | [ Edit | [ Run | [ Delete | [ Unselea View Archives | Manage Cateqories
I ] Category A  Report Schedule Archived Criteria
¥ Desktop Performance Applications with High Page Faults u] Last 24 Hours, Threshold 10000
] Desktop Performance Diagrostic Findings u] Last 24 Hours
] A Click on row to select report, then click gh Context Switches u] Last 24 Hours, Threshold 750
[0 0 on=earch Archives to find previous runs gh CPU Usage 0 Last 24 Hours, Threshald 10
or click Run button to generate report
O figh Disk 10PS 0 Last 24 Hovrs
F] Desktop Performance Machines with High Memary LUsage 0 Last 24 Hours, Threshold 60
I Desktop Performance Machines with High Metwork IO u] Last 24 Hours, Thrashold 40

3.4 Inventory

In the Inventory section of the Stratusphere UX product, you can view information on the Machines (desktops
Users and Applications in your environment. Once you have installed your Hub and deployed Connector ID
Keys to the target desktopbgtinventory information will automatically begin populating, and data will be
updated regularly (according to the Callback Frequency defined for the Connector ID Keys as discussed in
previous section above). Select individual items from the Inventasydisd click on the Edit button to view

more details for example select a Machine and click Edit to view the configuration data gathered from that
machine. The Inventory section is also where you can create and manage groups.
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Print Help Log Out

;Stratusphere’

Diaghostics Inventory Policy Administration

5 L lIse buttons or drop-dowen to Search for
[ | Machines | Llsers Applications Subnets take actions on selected items 4I0|ick to manage groups items by name
Machines )y \l Page

New | Selected 1: | Edit | [ 4ddTo Group | [ Delete | [ Unselect |[More actions.. ¥ view: Individual Machines | Groups | || search
A Connector ID

[ Name Type 05 Yersion A Key Version Created On Last Contact

O mpnocic-3 \irtLal Microsoft Windows XP Professional, Service metrided.6.0-1 May 3, 2010 2:54:32 PM May 12, 2010 4:40:50

EDT

PM EDT
May

Pack 3

i | 010 <:41:06
P EDT

May 12, 2010 4:35:50

Click on row to select Microsoft wWindowes ¥P Professional, Service May 3, 2010 2:54:29 PM

il o for it vitual oo w3ztd-4.6.0-1 1 e
) ) Microsoft wWindows XP Professional, Service ) May 3, 2010 2:54:32 PM May 12, 2010 4:45:03
[ nprocid-1 Wirtual Pack 3 nietcid-4.6.0-1 EOT PM EDT
. ) Microsoft Windows XP Professional, Service . May 3, 2010 3:35:20 PM May 12, 2010 4:45:00
[ npnocid-8 Yirtual Pack 3 cid32-4.6.0-1 DT P EDT
) ) Microsoft wWindows XP Professional, Service ) May 3, 2010 2:54:32 PM May 12, 2010 4:4<4:10
[ npnaocid-2 Wirtual pack 3 netcid-4.6.0-1 EOT PM EDT
; Microsoft®E Windows Server® 2003 q May 3, 2010 2:00:00 P May 3, 2010 12:54:11
0 10.10.6.169 Phwsical cyandard , Service Pack 1 RGBT PM EDT
»Stratusphere’ Print  Help = Log Out
Diagnostics Inventory Policy Administration
Machires | Users | Applications Subnets
Users Page 1 of 3 = Prev Mext =
MNew | Selected 1: | Edit | [ AddToGroup || Delete | [ Unselect | [More actions.. ¥ View: Individual Users | Groups |[ search ]
| Username Domain Email Address A Role Enabled Created On
[0 Administrator Qa administrator@tntga.com LUser May 3, 2010 3:34:58 PM EDT
daisyi@tntqa.com
¥ glargey _MEwhsst Qa glargey _Maiwhsst@tntga, com User May 4, 2010 11:03:03 AM EDT
] irina (] rina@tntga.com Lsgr Yes May 3, 2010 2:41:27 FM EDT
] irinatestl Qa irinatestl@tntga.com User Yes May 4, 2010 11:03:05 AM EDT
] irinatestz (] irinatest2@tntga. com Lsgr Yes May 4, 2010 11:03:05 AM EDT
i irinatest3 Ca irinatest3@tntga.com User Yes May 4, 2010 11:03:05 AM EDT
I ja Qa Jja@tntga.com User Yes May 4, 2010 11:03:03 AM EDT
o Stratusphere” Print  Help | Log Out

Diagnostics Inventory Policy Administration
Machines Lsers | Applications | Subnets
Desktop Applications Page 1 of 5 < Prev Next »
Wiew: Desktop Applications | Network Applications H Search
s verson  Mchnes | Estimated sie [istale Istalers Proceses
Adobe Flash Player 10 Activex 10.0.42 u]
Adobe Flash Player 10 Flugin 10.0.42 ]
Adobe Reader 9.2 9.2.0 u} acrord3z.exe
AntiMakware Service Executable 216518 0O MEMpeng. exe
Application Layer Gateway Service 5126800 2 43 alg.exe
CTF Loader 5125000 3 15 ctfmon. exe
Citrix XenCenter 2.5.0 u]
Client Server Runtime Process 5.1.2600 6 6 Csrss.exHe
Client Server Runtime Process 6.1.7600 O CSI55.8X8
Connector 1D 4.6.0 4 3,774 Yes Yes thtupdsye.exe, thtuidsve.exe, thtgrd.exe, thtcpl.exe
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For more details on the configuration of individual machines, go to Inventory > Machines, select a machine al
click on the Edit button. You can view details about the hardware, OS, installed applications and patches.

Print Help Log Out
on
Diaghostics Inventory Policy Administration
| Machires | Users Applications Subnets
Machines Page 1 of 2 2 Prev Next =
New | Selected 1 [ Edit |) add ToGroup | [ Detete | [ Unselect | [More actions.. %] view: Individual Machines | Groups |[ search
[ MName Type 05 Version A Eg;";iits?gnm Created On Last Contact
- ! ) May 3, 2010 2:54:29 PM | May 12, 2010 4:35:50
- : =y PM EDT
) ) Microsoft Windows XP Professional, Service ) May 3, 2010 225432 PM May 12, 2010 5:15:16
[ npnocid-1 Wirtual pack 4 netcid-4.6.0-1 EDT PM EDT
o Stratusphere’ Print = Help | Log Out

Diagnostics Inventory Policy Administration

| Machines | Users Applications Subnets

Edit Machine : nocid-6. tnfga.com

| Machine Properties | Machine Group Membiership Connectar ID Key Propertizs Installed Applications

This machine was imported from a WM directory, so some properties can not be changed. If you want to change these properties, change thern in the
directory and then re-import the machine through Y Directories in Administration.

05 Microzsoft Windows %P Professional, Service Monitors: 200 % 600;
Pack 3
Digks: 2 local;
CPU: Intel(R) ¥eon(R) CPU 5160 @ 3.00GHz, 1
care; Printers:
Age: 232 days MICs: “iware Accelerated AMD PCHet Adapter -

Packet Scheduler Miniport, 1,000 Mb;

Wi Directory: vsphere
Other devices: USB:WMware Wiew Wirtual USE Hub;

W Hosted on: esxz . mtga.com
Last Contact: May 12, 2010 4:353:50 PM EDT

Connector ID Key Yersion: w32tdi-4.6.0-1
Creation Date: May 3, 2010 2:54:29 PM EDT

sStratusphere’ prnt | elp | Log Out

Diagnostics Inventory Policy Administration

IMachines | Users Applications Subrets

Edit Machine : nocid-6. infga.com

Machine Properties Machinie Group Mermbershin Connector 1D Key Properties Installed Applications

| ’ Search ]
N . Estimated Installs Uses Installs Date
Application IR Size Services Services Drivers [FTEEEEEE Installed

Application Layer Gateway Apr 14,
Sorvice 5.1.2600,5512 43 alg.exe Sn0a

CTF Loader 5126005512 1S ctfmon.exe a1k
2008

i ) Apr 14,
Client Server Runtime Process  5.1.2600.5512 6 Carss.exe 2005

Yes . May 5,

Connectar ID 4.6.0.1 2,774 ‘e (3] (1) thtupdsye.exe, thtuidsyc. exe, tntgrd.exe, thtcplexe S0i0
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3.5 VDI UX Profile

TheVDIUX Profil e i s part -perddingVDIQUX rating system, ulseal b €antingoasty e n 1
rate desktop and user activity on virtual desktops to help categorize the expected user experience. The ratin
system categorizes a desktop or user on niriaaseeach one rated Good, Fair or Poor according to thresholds
defined in the profile. You can specify relative weights for each metric (zero to exclude a metric). Also, you
can autegenerate thresholds based on statistical measures taken from retoeiciah data.

To view or change the profile settings, login to Stratusphere UX and navigate to Diagnostics > VDI UX Profile
At the top of the page, you can choose to calculate thresholds based on historical data, either one time (in wi
case the tteshold changes will not be saved until you click Save Changes) ea@jugied in the background

on a daily basis. Note that you can recalculate VDI UX ratings for previously collected data when you Save
Changes.

Stratusphere’ Print Help | Log Dut

Diaghostics Inventory Policy Administration

SUMmMmary Inspector Reports Alerts | VDI UX Profile |

To see recommended

VDI UX Profile thresholds click here,
must Save Changes to
¥ Calculate Thresholds store and use Calculate Profile Settings
Generate baselines and thresholds from data over the previous |7 days

The baseline is the mean {(average) value for the specified time period, and the fair and poor thresholds are one- and two- standard deviations from the mean

Cnly include data when users are logged on to machines i

Check box to auto-adjust

[ auto-adjust and reset calculated baselines and thresholds daily ,
thresholds daily

Machine Experience Indicators

Login Celay : 20 0 <= 1§ <= |g0 <= unbounded

Time it takes to login (sec.) 2
Application Load Time : 20 0 <= |1p <= |3p <= unbounded

Awg. startup time for applications (sec.) 2
CPUQueue Length : |2p ] <= |3 <= | <= unbounded

Length of CPU gueue at inspection time 2
Page Faults : 20 0 <= |2.000 <= |10.000 <= unbounded

Mumber of page faults during inspection interval 2
Mon-Responding Applications : 20 0 <= |2 <= |3 <= unbounded

Mumber of unresponsive applications at inspection time 2

I/0 Experience Indicators

Disk Load : oK 0 <= |25 <= |[gp <= unbounded

Avg, disk [0 per second 2
Disk Queue Length : |25 0 <= <= |3 <= unbounded

Avg, length of disk queued(s) 2
Network Latency 2K 0 <= 150 <= |300 <= unbounded

Avg. network roundirip tirme (ms) 2
Failed Connections : 2K 0 <= | <= |15 <= unbounded

Mumber of outgoing connection attermpts that failed 2

& Do not recalculate YOI U for previously saved data Set weight to zero to
O Recalculate YOI UX for data back to fH exclude metrics

[ Save Changes ” Cancel ]
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4 Diagnostics 1: End-to-End Performance Analysis

Once you have deployed Stratusphere for monitoring, you are ready to begin generating reports and analyzir
the environment. This section provides you information on the key Inspector views and reports from the Rep
Library that will help yu analyze the performance of your VDI environment.

4.1 Virtual Machine Performance Analysis
To begin examining machine performance, navigate to Diagnostics > Inspector. Select the view Top Consun
Charts in the droglown and generate the charts for thegdiostics date range. Using this chart you can quickly

identify the top resource consumers.

Wigw: CPU | Mernoty | IO

Users User Most IO Applications Using Most I0
winlogon
iR a@THT A
explarar
£
" :g firefox
3 jeff u
= =
& swchost
=
Swstern
irina
csrEs
a 0.3 0.6 (1] 1.2 1.5 u 2 4 & g 1o
= I3 Rate (KBSs) = I Rate (KBSs]

To see summary details for each machine, select the Inspector view Machine Diagnostics Summary, change
Date Range to Last 24 Hours, and click theb@tion. This shows one row for each machine.

Hide Graphs | Export

¥DIUX Trend

c
=
ol
]
£
S
o
2
1
i 0
12:00 PM 01:00 PM 02:00 PM 0200 PM 04:00 F
05/13/10 05/13/10 05/13/10 05/13/10 05/13/1
= Good Fair = Paoor
Click to drill-down on row I
Page 1 of 1 £ Prev Mext =
_ ) Login  App. CPU Context Page Disk Disk Roundtrip .
Machine Hgé?;‘e L':;fo/l:; Delay Load gzg (%) Queue Switch ;43;16?"3) Fault IOPS Queue ﬁfr;w(.ﬁg(ls) Latency E;::Ir;réects ﬁ::s::;f:v ANR ﬁgl a
Avg.(s) Avg.(s) : Avg.  Avg. (/s) - Avg. Avg.  Avg. - Avg.(ms)
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To see further details, click on the chdlbwn button on the left side of a selected row, and-dioMn to see the
machine inspection history for a specific machine. This will show a breakdown forreperythat the
Connector ID Key sent back for the specified machine.
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To get a complete view of the machine, host, SAN, and application data gathered for the specific machine
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during this period, select the Inspector view Desktop 360° View and click Go.
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Next go to Diagnostics > Reports, click on Report Library, and run the following reports for the time period yo
are analyzing.

Report Name Description

Slow User Logins Identifies logins taking longer than specified threshold

Slow Application Loa@limes Identifies applications that took longer than specified number of seconds to loac
Top CPU Consuming Applications Shows the applications consuming the most CPU cycles

Top Memory Consuming Applications | Shows the applications using the most memory

Machines with High CPU Usage Identifies machines using more than specified threshold percentage of CPU
Machines with High Memory Usage Identifies machines using more than specified threshold percentage of Memory

4.2 Host Performance Analysis

To examine hogperformance, go to Diagnostics > Inspector and select the Host Performance Summary from
the dropdown list of views, then click the Go button. To see details about the machines running on a specific
host, drilkdown on the row.
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For the summary repooin host performance, go to Assessment > Reports, click on Report Library, and run the
following report for the diagnostics time period.

Report Name Description

Host Performance Summary | Lists summary averages statistics for each virtual host
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4.3 Network Performance Analysis

To gain a graphical view of network connections, with an ability to drill down on the performance data,
navigate to Diagnostics > Inspector, select the Network Connection Map from theadvopist of views, and
click the Go button.Next you will need to select one of your VMs as the Target Machine, then click the Draw

Map button.
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To view overall network performance data by application (port/protocol), navigate to Diagnostics > Inspector
and select the Network Application Summé&iom the view drogdown, click on the Go button. To view data
for a specific application such as RDP, select the application from the filteddvap at the top of the page.
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To print reports on network performance, go to Diagnostics > ReportspdiReport Library, and run the
following reports (note that the reports are in two categories, the category can be changed withdbemiaip

the top of the library page).

Category

Report Name

Description

Desktop Performance

Machines with HigiNetwork 10

Identify machines with network IO exceeding specified thresh

Desktop Performance

Machines with High Network Lateng

Identify machines with latency exceeding specified threshold

Desktop Performance

Top 10 Consuming Applications

The top IGconsuming applications

Network Activity

Network Activity by Application

Summary network performance by application (port/protocol)
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4.4 SAN Performance Analysis

To view SAN performance data, with an ability to ddddwn and find the specific machines applications
consuming SAN, go to Diagnostics > Inspector and select SAN Diagnostics Summary from the view drop
down and click the Go button. The list of datastores is displayed, and you caownlito see the trend graph
and the VMs (that have ConnecID Keys) using the datastore during the specified period.

To print reports on the application and document inventory data, go to Diagnostics > Reports, click on Report
Library, and run the following reports for the diagnostics time period.

ReportName Description
Overall SAN Performance Summary of SAN performance information by datastore
SAN Activity by Machine SAN performance and usage data by virtual machine

Machines with High Disk IOPS ldentify virtual desktops with IOPS exceeding a spedifiseshold

Top IO Consuming Application Top 10 consuming applications for a specified time period
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